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Lesson Objectives

Lesson Objectives
To edit the company Chart of Accounts
To add a new customer to the Customers & Jobs list
To add a new vendor to the Vendor list
To learn about custom fields and to practice adding custom fields
To see how to manage lists in QuickBooks
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Using QuickBooks Lists

Using QuickBooks Lists
QuickBooks lists organize a wide variety of information including data on customers, vendors, inventory items and
more. Lists save you time by helping you enter information consistently and correctly. Such as:
Names, addresses and other information about customers
Contact information for vendors
Descriptions and prices for products and services

NOTES
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Editing the Chart of Accounts

Editing the Chart of Accounts
The Chart of Accounts is your most important list because it shows how much your business has, how much it owes,
how much money it has coming in, and how much it is spending.

To display the Chart of Accounts:
1. From the Lists menu choose Chart of Accounts or press CTRL+A.

2. Scroll through the list.
The Chart of Accounts displays balance sheet accounts first, followed by income and expense accounts by default.
Optionally, you can click on the column headings to sort by name or balance instead of type.

NOTES
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Editing an Account

Editing an Account
To edit an account:
1. In the Chart of Accounts, find the account you want to edit, and then click on it one time to highlight the row.
2. Right-click on the row and click Edit or click the Account menu button then select Edit Account.
3. Edit the information accordingly.

4. Click Save & Close .

IMPORTANT: Some information, like Account Type, is not easily changed. If you setup an account in error and

you are trying to modify it, you can delete the account and start over, assuming no transactions have been
posted to it.

NOTES

QuickBooks 2016 Student Guide

8

Lesson 3 — Working with Lists

Adding a Subaccount

Adding a Subaccount
A subaccount is a way of breaking an account down in to subcategories for reporting purposes. Subaccounts show
as indented lines on reports under the main, or ‘parent’ account. This hierarchy enables you to expand reports to
show all subaccounts under a parent, or to collapse all subaccounts into a parent account for one line view on
reports.

To add a subaccount:
1. In the Chart of Accounts, click the Account menu button and then choose New.
2. Select the appropriate account type (this must be the same account type as the parent account).
3. Click Continue.
4. Assign an appropriate account name and number if applicable.
5. Select the Subaccount of checkbox, then select the parent account from the drop-down list.

6. Click Save & Close.
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Adding a Subaccount

QuickBooks displays the new subaccount in the Chart of Accounts list.

7. Close the Chart of Accounts.

NOTES
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Customer, Vendor and Employee Centers

Customer, Vendor and Employee Centers
The Customer, Vendor and Employee Centers consolidate and organize important information. The centers contain
names, addresses and other information about the names on these lists. They also hold more specific information,
Contacts, Notes, To Do’s and Sent Emails, custom fields and other details you may want to track for each customer,
vendor or employee.
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Custom Contact Fields

Custom Contact Fields
The Customer, Vendor and Employee Centers include eight fields for custom contact information. All eight of these
contact fields for phone numbers, email addresses and URL’s can be customized per the drop-down list of available
contact descriptions (mobile phones, social media information, etc.).

NOTES
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Working with the Customer Center and the Customers & Jobs List

Working with the Customer Center and the Customers & Jobs List
The Customer Center’s Customers & Jobs list stores names, addresses and other information about your customers.
It also holds information about the jobs or projects you may want to track for each customer.

ADDING CUSTOMERS
Your Customer list is the list that will display sales forms (sales orders, estimates, invoices, sales receipts) and
Accounts Receivable.

To add a customer:
1. There are multiple ways to do almost anything in QuickBooks. To access the Customer Center, you have four
options:

 Click Customers from the left hand or top icon bar (depending on your View settings)
 Choose Customer Center from the Customers drop-down in the menu bar
 From the Home Screen, click on the blue Customers tab in the Customers section
 Press CTRL+J
2. Click the New Customer & Job menu button then choose New Customer.
3. In the Customer Name field, enter the name of the customer as you'd like it to appear on your Customers & Jobs
list.
4. Press Tab in the Opening Balance field to leave this field blank.
The Opening Balance field tells you how much each customer owes you on your start date so that when you
enter the rest of your transactions from the day after your start date to today, all balances since your start date
will be accurate.
It is generally recommended entering individual outstanding invoices one by one whenever possible, rather than
entering the outstanding balance owed in the Opening Balance field.
5. Complete the customer contact information appropriately.
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Working with the Customer Center and the Customers & Jobs List

You can have and use more than one Ship To address per customer or job. Add them with the Ship To dropdown or by clicking the + sign in the bottom right corner.

6. Click OK to add this customer.
The Customer Center appears with the Customers & Jobs list along the left side.
IMPORTANT: The Customers & Jobs list is the same list as the Customer/Job list. It is called Customers &

Jobs on the Customer Center and called Customer:Job on forms. It is sometimes also referred to as simply
the Customer list.

PROVIDING ADDITIONAL CUSTOMER INFORMATION
There are additional tabs for Payment Settings, Sales Tax Settings, Additional Info and Job Info where you can
provide other important information.

NOTES
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Sales Tax Settings

Sales Tax Settings
There are multiple levels of taxability in QuickBooks. Taxability can be assigned by the item, the customer, and each
individual sale for:
Item default taxability – This determines whether the item is displayed as taxable or nontaxable each time it is
used on a sales form. This is a default setting that can be changed on the individual form when the item is used.
Customer default taxability

 Tax Code – Here you can set a customer to be taxable or nontaxable. If the customer is set up as
nontaxable, this overrides the item setup when taxable items are used on a sales form. This can be changed
on a sales form.

 Tax Item – This is the line tax item to which the customer’s sales will default on the Sales Tax Report. If the
customer’s tax code is Tax, the rate from the Tax Item drop-down will be assigned. If the customer’s tax
code is Non, the rate will not be applied, but the sale will still be grouped with that rate in the Sales Tax
Report. This can also be changed on a sales form.

NOTES
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Sales Tax Settings

The Payment Settings tab is the place where you enter customer account numbers and credit limits. You can also
record information about each customer’s payment terms, preferred delivery method of invoices, and preferred
payment method. For customers who pay by credit card, you can enter credit card numbers and expiration dates.

NOTES
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Transactions from the Customers & Jobs List

Transactions from the Customers & Jobs List
Right-clicking on any customer or job in the Customers & Jobs list will bring up a menu which includes access points
for launching various customer-related transactions and features, such as:
Create Invoices
Create Credit Memos / Refunds
Create Estimates
Create Statements
Enter Sales Receipts
Enter Statement Charges
Create Sales Orders
Receive Payments
Make Deposits
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Working with the Employee Center

Working with the Employee Center
To add a new employee:
1. Just like the Customer Center, are multiple ways to access the Employee Center in QuickBooks:

 Click Employees from the left hand or top icon bar (depending on your View settings)
 Choose Employee Center from the Employees drop-down in the menu bar
 From the Home Screen, click on the blue Employees tab in the Employees section
2. Click New Employee at the top of the Employee Center.

3. Complete all employee information.
4. Click OK.

IMPORTANT: Payroll requires additional setup to be ready for processing inside of QuickBooks.

NOTES
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Working with the Vendor Center

Working with the Vendor Center
The Vendor Center’s Vendor list is the place where you record information about the companies or people from
whom you buy goods or services.

ADDING VENDORS
In order to pay your bills with QuickBooks, you need to add your vendors (sometimes referred to as suppliers). Nearly
everyone you pay, other than employees, is a vendor. Your vendor list supplies the names available on purchase
forms like purchase orders, bills, checks, vendor credits, sales tax payments, payroll tax payments and bills.

To add a vendor:
1. Just like the Customer Center and Employee Center, there are multiple ways to access the Vendor Center in
QuickBooks.

 Click on Vendors from the left side or top icon bar (depending on your View settings)
 Choose Vendor Center from the Vendors drop-down in the menu bar
 From the Home Screen, click on the Vendors tab in the Vendors section
2. Click the New Vendor button then choose New Vendor.
3. In the Vendor Name field, enter the name of the vendor as you'd like it to appear on your Vendor list.
4. In the Opening Balance field, this is treated the same as the Customer Center entries. You can enter a balance
owed to the vendor as of the start date of the file, but it is best practice to enter individual open bills when you
can.
5. Enter the remaining vendor information appropriately.
6. Click OK to add this vendor.
The new vendor appears on the Vendor list.

7. Close the Vendor Center.
QuickBooks 2016 Student Guide
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Working with the Vendor Center

IMPORTANT: Notice that there are additional tabs in the vendor setup window. Feel free to utilize these

features as they apply to your business. Pay special attention to the Tax Settings tab if you would like to run
1099 reports from QuickBooks.
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Transactions from the Vendor List

Transactions from the Vendor List
Right-clicking on any vendor in the Vendor list will bring up a menu which includes access points for launching
various vendor-related transactions and features, such as:
Write Checks
Enter Bills
Pay Bills
Enter Credit Card Charges
Create Purchase Orders
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Adding Custom Fields

Adding Custom Fields
QuickBooks lets you add even more information to names on various lists by having custom fields in the Customers
& Jobs, Vendor, Employee and Item lists. Custom fields give you a way to track additional information specific to your
business.

To add custom fields:
1. Open the Customer Center (or the Vendor Center or the Employee Center).
2. Click on a customer (or vendor or employee, depending on the center you’ve opened).
3. Click the Edit (pencil) button (alternately, right-click on the customer name and choose Edit).
4. Click the Additional Info tab.
5. In the bottom right corner of this window, click Define Fields. This opens up the Custom Fields window, which
corresponds to your Customer, Vendor and Employee lists.

6. Use the Label column to name your custom field.
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Adding Custom Fields

7. Place a check mark in the column for each name list to which you would like the custom field to apply.
QuickBooks Pro and Premier allow for up to seven custom fields for each of the Customer, Vendor and
Employee Lists, but with no more than an aggregate limit of 15 custom fields on all these lists together.
8. Click OK.
9. If you see an informational message, click OK.
10. Click OK to close the Edit Customer (or Edit Vendor or Edit Employee) window.
11. Close the Customer (or Vendor or Employee) Center.

NOTES
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Adding Custom Fields

To add custom fields for items:
1. From the Lists menu, choose Item List.

2. In the Item list, select the item you wish to edit.
3. Right-click on the item and choose Edit Item or click the Item menu button then choose Edit Item.
4. Click Custom Fields.
5. Click Define Fields.
6. Enter the custom field name that you would like to use in the Label column.
7. Place a checkmark in the Use column for the field to show in the item setup. QuickBooks Pro and Premier allow
for up to five custom fields for items.

8. Click OK to close the window.
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Adding Custom Fields

9. In the Custom Fields for this (or any) item window, you can now enter information in to your custom field.

10. Click OK to close the Custom Fields window, then click OK to close the Edit Item window.
11. Close the Item list.

NOTES
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Managing Lists

Managing Lists
Sometimes, you may want to re-order the way that your accounts appear in the different sections of your financial
reports. You can re-order each section of your Chart of Accounts (within its account type) by following the
instructions below.

To sort a list manually:
1. From the Lists menu, choose Chart of Accounts. Scroll to the account you would like to move.
2. Click the diamond to the left of the account name.
3. Click and hold the mouse button and drag the pointer upward until you see a dotted line directly below the
account name.
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Managing Lists

4. Release the left mouse button to drop the account in the new position.

5. To re-sort the list alphabetically, click the Account menu button in the bottom left corner of the Chart of Accounts
screen and select Re-sort List.
6. Click OK.
7. Close the Chart of Accounts.
You can sort lists in QuickBooks by clicking on column headers like the Name and Balance Total. The example below
uses the Customer Center, but this also applies in the Vendor Center, Item list and Chart of Accounts.
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Managing Lists

To sort a list in descending order:
1. Open the Customer Center (using any of the access methods described above) and Customers & Jobs list.
2. Click the expand arrow to the right of the View drop-down list to expand the width of the Customers & Jobs list.
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Managing Lists

The full list view of the Customers & Jobs list displays.

3. Click the Balance Total column heading. This sorts the list in ascending order by balance total.
4. Click the column heading again. This sorts the list in descending order by balance total.
5. To return to the original order, click the large diamond to the left of the Name column heading. (Alternately, rightclick anywhere in the list and choose Resort List, then click OK.)
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Managing Lists

6. Click the collapse arrow to the right of the window to collapse the Customers & Jobs list.

7. Close the Customer Center.

NOTES
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Managing Lists

In most lists, you can combine two list names into one. This is called merging. For example, you may find that you’ve
been using two customers (because of different spellings) when you really need only one on your Customers & Jobs
list. You can merge list items in the Chart of Accounts, Item, Customers & Jobs, Vendor, Employee and Other Names
lists. This example uses the Vendor list, but the concept is the same regardless of list type.

To merge items on a list:
1. Open the Vendor Center.
2. Double-click the entry you wish to merge (this entry will be merged into the other entry and any informational
fields associated with this list entry will be lost so make sure you have all the information you need in the other
entry).

3. In the Vendor Name field, change the name to match the name of another vendor record with which you wish to
merge. This should be an exact match, in terms of spelling, spacing and punctuation.
4. Click OK.
5. You will get a warning dialogue telling you that there is another record with this name and asking if you would like
to merge. (Remember, you can never un-merge so be very sure that this is what you want to do.) Click Yes.
6. Close the Vendor Center.
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Managing Lists

IMPORTANT: You cannot merge two names from different lists such as a Vendor and Customer record or

Other Names list record. All transactions containing the original list name will now appear as if they were
entered using the renamed, merged list name.

RENAMING A LIST ITEM
You can rename any list name. When you make the change, QuickBooks automatically modifies all existing
transactions containing the list name. (This is very similar to the concept of merging, but without renaming a name to
be exactly the same as another name on the same list.) This example demonstrates renaming in the Chart of
Accounts.

To rename a list item in the Chart of Accounts:
1. From the Lists menu, choose Chart of Accounts to display the Chart of Accounts for Rock Castle Construction.
2. In the Chart of Accounts, select the account you would like to rename.
3. Right-click on the account and click Edit Account or click the Account menu button and choose Edit Account.
4. Make your changes in the Account Name field.
5. Click Save & Close.
6. Close the Chart of Accounts.

NOTES
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Managing Lists

You can delete list items if you have not used them in any transactions (or preferences or customized report filters). If
you try to delete a list item that is used in a transaction (or preferences or customized report filters), QuickBooks
displays a warning that the item can’t be deleted. If you don’t want to use a list item but you can’t delete it, you can
make it inactive. Here is an example from the Customer Center.

To make a list item inactive:
1. Navigate to the Customer Center.
2. Select the Customer or Job from the list that you wish to make inactive.
3. Right-click the name and choose Make Customer:Job Inactive.
4. To see inactive list items, choose All Customers from the View drop-down list.

5. Close the Customer Center.

NOTES
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Printing a List

Printing a List
You can print a QuickBooks list for reference, or you may print a list to a file to use in your word processor or
spreadsheet. QuickBooks prints the Customers & Jobs list as it appears on the screen. For example, if the
Customers & Jobs list is expanded and sorted by balance total, QuickBooks prints the expanded list sorted by
balance total. If the list is collapsed, QuickBooks prints just the customer name, the balance total and active status.

To print the Customers & Jobs list:
1. In the Customer Center, click the Print menu button then choose Customer & Job List.
2. Click OK to bypass the List Reports message.
3. Click Print.

To print information on one customer:
1. In the Customers & Jobs list, select the customer whose details you want to print.
2. Click the Print menu button, then choose Customer & Job Information.
3. Click Print.
If you want to print information for selected customers only, you can generate and filter the Customer Contact List
report for those customers. You can also modify the report to include any extra columns that you want.
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Printing a List

To print information for selected customers:
1. From the Reports menu, choose List then choose Customer Contact List from the submenu.
2. Click Customize Report.
3. Click the Filters tab.
4. Select Customer in the Filter list.
5. In the Customer field, choose Multiple customers/jobs.
6. Make sure that the radio button next to Manual is selected, and then click to put a checkmark next to those
customers for whom you want to print contact information.
7. Click OK to close the Select Customer/Job window.
8. Click OK to close the Customize Report window and display the customized report on the screen.
9. Print the report.
10. Close the Report window.
11. Close the Customer Center.

NOTES
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Adding or Editing Multiple Items at One Time

Adding or Editing Multiple Items at One Time
If you have existing list information in Microsoft Excel® that you want to add to QuickBooks or if you want to make
changes to multiple items, you can do so for items in the following lists: Customers, Vendors, Service Items and Noninventory Parts. (Multiple items may also be added to or edited in the list of Inventory Parts, if the inventory preference
is turned on.)

To edit or add multiple list names at once:
1. Go to the Lists menu and choose Add/Edit Multiple List Entries.
2. Choose the list you would like to edit from the List drop-down.
3. Use the Customize Columns button to customize the information you would like to see. (This means not only
adding and taking away columns, but also changing their order.)

4. Use the Find field if needed.
5. Utilize copying tools by right-clicking in a cell on the grid.
6. To add any new list names, you can scroll to the bottom of the list and start entering or pasting information into
the first empty row. Alternately, you can change the view to show Unsaved list names (in the example above, that
would be Unsaved Customers) and you will be able to start entering or pasting information into an empty grid,
using the column headers as your guide.
7. When your changes are complete, click Save Changes.
8. Close.
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Working with the Lead Center

Working with the Lead Center
The Lead Center tracks data about your sales prospects (who are not yet customers) in one place inside
QuickBooks. The Lead Center has three panes:
Use the Leads pane on the left to view and sort your leads
Use the Lead Information pane on the right to review or edit information about a selected lead
Use the Tabs at the bottom of the window to access lists and notes for individual leads
To access the Lead Center, click on Company on the menu bar and select Lead Center. QuickBooks displays the
Lead Center as shown:
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Working with the Lead Center

To add a new lead:
1. Choose Company > Lead Center.
2. Click the New Lead icon.
3. Enter the lead name in the Lead field.
4. Set the lead status. Click the Status drop-down arrow and select Hot/Warm/Cold.
5. Use the Company and Contacts tabs to enter information about the prospect.

6. Enter additional information as desired.
7. Click OK.
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Working with the Lead Center

THINGS TO NOTE ABOUT THE LEAD CENTER
Each lead must have a unique name. If you've already used the name, change it slightly by adding a character or
number.
The Contacts tab provides the ability to enter details about contacts at the company. You can have multiple
contacts as needed.
You can enter one or more locations in the Location field. If you have multiple locations, you can click the Main
Address drop-down arrow and select from the locations you've entered.
You can import multiple leads to enter multiple prospects into Lead Center at the same time by using the Import
Multiple Leads button at the top of the Lead Center and copying and pasting from an Excel spreadsheet.

To convert a lead to a customer:
You can convert a lead into a customer when needed. This will move the prospect from the Lead Center to the
Customer List. Converting a lead to a customer cannot be undone.

IMPORTANT: You cannot enter a transaction for a Lead — first it must be converted to a Customer.

NOTES
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Working with Lists — Review Questions

Working with Lists — Review Questions
1. How many custom fields can you set up for items?
a. 4
b. 5
c.

7

d. 20
2. Which of the following forms and windows could potentially be populated with information from the Vendor list?
a. Purchase orders
b. Bills
c.

Write Checks

d. All of the above
3. Which of the following activities cannot be accessed from the Customers & Jobs list in the Customer Center?
a. Create statements
b. Assess finance charges
c.

Enter credit card charges

d. Receive payments
4. On which tab of the Edit Customer window would you enter a customer’s payment terms (for example, Net 30
Days)?
a. Address Info
b. Additional Info
c.

Payment Settings

d. Job Info
5. A customer has three warehouses and you are installing an overhead door at each location. The best way to
track this in QuickBooks would be to:
a. Set up each location as a separate customer
b. Set up a separate job for each location under the customer
c.

Enter all work as one order under the customer

d. Use a custom field to track each location
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Working with Lists — Review Questions

6. Products you sell would appear on which of the following lists?
a. Vendor list
b. Employee list
c.

Chart of Accounts

d. Item list
7. A subcontractor would appear on which of the following lists?
a. Vendor list
b. Employee list
c.

Customers & Jobs list

d. Item list
8. Name three of the lists on which you can merge names.
a. ________________________________________
b. ________________________________________
c.

________________________________________

9. True or false: You can delete list items that are used in transactions.
a. True
b. False
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Review Activities

Review Activities
1. Add the following customer using the data below:

 Customer Name: Alla Rozenvasser
 Opening Balance: $234.00
 Company Name: Rozenvasser Advertising
 Contact: Alla Rozenvasser
 Bill to: 300 Main Street, Suite #3, Middlefield, CA 94432
 Phone: 415-555-6767
 Fax: 415-555-9090
 Alt. Contact: Shannon Stubo
 Type: Commercial
 Credit Limit: $2500
 Terms: Net 15
 Tax Item: San Domingo
2. Add a new vendor using the data below:

 Vendor: Martin Drywall
 Contact: Sean D. Martin
 Address: P.O. Box 76, Middlefield, CA 94432
 Phone: 555-5432
 Fax: 555-6565
 Account: 082-4343
 Type: Subcontractors
 Terms: Net 30
 Credit Limit: 1,000.00
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Review Activities

3. In the Customers & Jobs list select Ecker Designs. Answer the following questions:

 What is the job status for Ecker Designs’ office repairs?
 What is the number of the most recent invoice and how much was it?
 What happened on December 11th?
4. In the Vendor Center locate sales tax payment transactions. Answer the following questions:

 Who is the vendor?
 How many payments have been made?
 What is the total amount of payments that have been made?
5. In the Employee Center find Gregg Schneider’s information. Answer the following questions:

 What is the name of his spouse?
 When was Gregg hired?
 What is Gregg’s overtime pay rate?
6. In the Vendor Center find C.U. Electric. Answer the following questions:

 What is open balance for this vendor?
 How many bills are outstanding and what are the amounts?
 What are the payment terms for this vendor?
7. Open the Item list and answer the following questions:

 How many brass hinges are on hand?
 What is the price of a patio door?
 What is the finance charge percentage on overdue balances?
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Answers to Review Questions

Answers to Review Questions
1. How many custom fields can you set up for items?
a. 4
b.

5

c.

7

d. 20
2. Which of the following forms and windows could potentially be populated with information from the Vendor list?
a. Purchase orders
b. Bills
c.

Write Checks

d.

 All of the above

3. Which of the following activities cannot be accessed from the Customers & Jobs list in the Customer Center?
a. Create statements
b. Assess finance charges
c.

 Enter credit card charges

d. Receive payments
4. On which tab of the Edit Customer window would you enter a customer’s payment terms (for example, Net 30
Days)?
e. Address Info
f.

Additional Info

g.

 Payment Settings

h. Job Info
5. A customer has three warehouses and you are installing an overhead door at each location. The best way to
track this in QuickBooks would be to:
a. Set up each location as a separate customer
b.

 Set up a separate job for each location under the customer

c.

Enter all work as one order under the customer

d. Use a custom field to track each location
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Lesson 3 — Working with Lists

Answers to Review Questions

6. Products you sell would appear on which of the following lists?
a. Vendor list
b. Employee list
c.

Chart of Accounts

d.

 Item list

7. A subcontractor would appear on which of the following lists?
a.

 Vendor list

b. Employee list
c.

Customers & Jobs list

d. Item list
8. Name three of the lists on which you can merge names. (Any 3 of these will do.)
a.

 Chart of Accounts

b.

 tem

c.

 Customer & Jobs

d.

 Vendor

e.

 Employee

f.

 Other Names

9. True or false: You can delete list items that are used in transactions.
a. True
b.

 False
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